Programos nustatymai:

PASTABA: kiekvieng kartg kompiliuojant ar

1. jeinerodo eilu¢iy numeriy:
Tools > Editor options > Display > Line
numbers

2. Failo sukiirimas CodeBlocks:
File >New > Project:
> Files
» C/C++ source > go > next > C++
» Pasirenkame saugojimui katalogg
» jrasome failo varda

3. Failo sukiirimas DevC++ programa:
> File > New > Source File

4. Darbo jra§ymas:
> File > Save > katalogg palickame
jau sukurtg > jrasome tik failo
varda

startuojant programai pakeitimai patys iSsisaugo.

Programos struktira

Priemoniy apras§ymas:
» bibliotekos,
» konstantos,
» Kkintamieji

Funkcijy prototipai

Pagrindinés funkcijos main()
kintamyjy ir veiksmy sakiniai

Funkcijy tekstai
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Project [*] pasisveikinimas.cpp

1 # include <iocstream:
2 # include <conic.h>
3 # include <locale>

£ # include <cmath:

5 # include <iomanip>
6
7

using namespace std;

a main ()

10 _

11 i double x;

12 | setlocale (LC_CTYPE,"");

13 fcin > g

14 cout << "Jasy jvestas skaifius " << fixed << setprecision (2) << x << " Programa baigé darbg.” << endl;
15 :

16

17 i getch();

18 return 2;

19 L0

EE Compiler I E Resources I d]]] Compile

Log |Q/ Debug I@ Find Results

Line: 19 Col: 2 Sel: 0

Lines: 19 Length: 786 Insert Done parsing in 0,437 seconds

using namespace std;

int main()

{

return O;

¥

==> raSomas visada, kai j programa jterpiamas antrastinis failas (pvz.: iostream)

==> pagrindin¢ funkcijos antrasté

==> nurodo programai baigti funkcijos darba




Bibliotekos
visos bibliotekos prasideda #include

==> nurodo, kokiy faily tekstai bus jtraukti j programa

DevC++

CodeBlocks
<iostream> ==> duomeny jvedimui, i§vedimui j ekrang
<fcntl.h> ==> lietuviskiems raSmenis iSvesti j ekrana
<jo.h> ==> lietuviskiems raSmenis iSvesti j ekrang
<iomanip> ==> kad galétume naudoti manipuliatoriy, kuris

leidzia raSyti realius sk. su nurodytu skaitmeny kiekiu po
kablelio

<conio.h>  ==> naudojama konsolés jvesties / i§vesties.
Dazniausiai naudojamy funkcijy conio.h yra clrscr, getch, getche,
kbhit t.t. Funkcijos conio.h gali btiti naudojamas i$valyti ekrana,
pakeisti spalva teksto ir fono, perkelti teksta.

<iostream> (iostream.h — senesnei versijai) ==>
duomeny jvedimui, i§vedimui j ekrang
<locale> ==> lietuviskiems raSmenis iSvesti ] ekrang

<iomanip>  ==> kad galétume naudoti manipuliatoriy, kuris
leidzia rasyti realius sk. su nurodytu skaitmeny kiekiu po
kablelio

<conio.h>  ==> naudojama konsolés jvesties / ivesties.
Dazniausiai naudojamy funkcijy conio.h yra clrscr, getch, getche,
kbhit t.t. Funkcijos conio.h gali biiti naudojamas iSvalyti ekrana,
pakeisti spalva teksto ir fono, perkelti teksta.

<fstream> ==> naudojama jvesti / iSvesti duomeny srautus | | <fstream> ==> naudojama jvesti / i§vesti duomeny srautus j
failg failg
<string> ==> darbui su simboliy eilutémis <string> ==> darbui su simboliy eilutémis
Duomeny iSvedimas
cout<<"' Rasome, teksta, kurj norim pamatyti ekrane"" << endl;
endl; == > naudojame, norédami, kad kitas prane§imas

cout << "* Labas. Tai miisy pirmoji C++ programa *" <<

endl;

left == > igvedant duomenis, jie lygiuojami pagal kairj krasta
right == > igvedant duomenis, jie lygiuojami pagal deinj krasta

setw (n) == > nustato isvedamy duomeny lauko plotj n

setprecision (n) == > nustato realiojo skai¢iaus i¥vedamy skaitmeny

skai¢iy n

biity raSomas naujoje eilutéje

inta = 45;

double b = 123.258;

cout << a;

cout << setw (5) << a <<" "<< fixed << setprecision (2)
<< b <<endl;

Ekrane matysite:

[415| | | [4]5] [1]2[3].[2]6] ]|
Paskutinis skaicius suapvalintas, nes nurodyty pozicijy
skaiius per mazas

Duomeny jvedimas

cin>>kintamojo vardas (vardai, atskirti >> zenklu);

cin>>a>>h>>c;

http://www.youtube.com/playlist?list=PL4F3C96A7A402E9DB&feature=plcp

Kintamuyju tipai:
Kintamojo tipas Maziausia Didziausia llgis baitais
reik§meé reik§mé
bool Loginé reikSmé: true (1) arba false (0) false true 1
char Vienas simbolis *A°, '8 arba skai¢ius [-128; 127] -128 128 1
int Sveikasis skaiCius -2147483648 | 2147483647 4
|0ng Sveikasis skaiCius (didesnis skaiiy intervalas) -231 231-1 4
double Realusis skai¢ius -2_23*]_0'308 1,79*]_0308 8 (15 zenkly tikslumas)
float Realusis skai¢ius (tik duoda maziau skaitmeny po kablelio) -3.4*10% 3.4*10°° 4 (6 zenkly tikslumas)
long double | Realusis skaicius (tik duoda daugiau skaitmeny po kablelio) | -1,7*10™"° 1,7%10°% 10 (20 Zenkly tikslumas)



http://www.youtube.com/playlist?list=PL4F3C96A7A402E9DB&feature=plcp

Kintamyjy apraSymas:
double pi = 3.1415;
inta=5,b=3;
chara=‘A’;
bool statusis = false;

Kintamojo galiojimo pradzia — jo apraSymo vieta. Kintamasis galioja tame programos bloke, kuriame jis yra
aprasytas. Blokg sudaro programavimo kalbos sakiniy seka, parasyta tarp riestiniy skliausty { }

Aprasant kintamuosius, reikia prisiminti:
e Kintamieji, apraSyti prie$ pagrinding funkcija main(), vadinami globaliaisiais. Jie galioja visoje
programoje.
¢ Kintamieji, aprasyti funkcijoje, vadinami lokaliaisiais. Jie galioja tik toje funkcijoje, i§¢jus uz funkcijos
¢ riby, Siy kintamyjy reikSmés neissaugomos.
e Jei kintamasis tokiu paciu vardu aprasytas prie§ pagrinding funkcija main() ir funkcijoje, pirmenybé
suteikiama lokaliajam, t. y. funkcijoje globalusis kintamasis negalioja.

PRISKYRIMO SAKINYS

Priskyrimo sakinys naudojamas, kai kintamajam reikia suteikti reikSme¢ programos tekste.

Priskyrimo sakinio struktiira tokia: kintamojoVardas = ReiSkinys;

Cia simbolis = Zymi priskyrimo operacija, o Reiskinys nurodo, kokius veiksmus, kokia tvarka ir su kokiais
argumentais reikia atlikti. Kairiojoje priskyrimo operacijos pus¢je jrasytas kintamojo vardas nurodo, kam
atmintyje suteikiama apskaiciuota reiskinio reikSmé.

Pavyzdziui, priskyrimo sakinys

y=X*X;
reiskia, kad argumento X reik§mé keliama kvadratu ir rezultatas priskiriamas kintamajam y

Sudétinis sakinys — tai tarp riestiniy skliausty { } paraSyta sakiniy seka

Pavyzdziui
{

n=n+1;

suma = suma+n;
}
Aritmetinés operacijos
+ sudétis +
- atimtis N
* daugyba I I — I
I sveiky skai¢iy dalyba (skaicius iki kablelio) /
% sveiky skai¢iy dalyba (sveikoji liekana) %
n=n+k; n+=k; +
n=n-k; n-=k; -

* —

n=n*k; n*=k; I 2 / I - I 2
n=n/k; (fps > div) n/=k; %
n=n % k; (fps > mod) |n%-=k;
n=n+1,; ++n; arba n++;
n=n-1; --n; arba n--;




&& loginiam reizkiniui — IR (loginé daugyba) Kintamyjy reik§meés Loginiy reiSkiniy rezultatai

I loginiam reiskiniui — ARBA (loginé sudétis) a b a&&b | afb la

I loginiam reigkiniui — NE true true true true false
> DAUGIAU: true false false true false
< MAZIAU: ’ false true false true true
>= DAUGIAU ARBA LYGU: false false false false true
<= MAZIAU ARBA LYGU;

I= NELYGU;

== loginiam reiskiniui — LYGU

SALYGINIS SAKINYS

if (@>0) ats=sqrt(a);
else cout << “ Saknies i$ neigiamo skaiciaus iStraukti negalima” ;

if ( ) pirmas sakinys;

salyga

else antras sakinys;

Salyginiu sakiniu programoje kei¢iama nuosekli sakiniy atlikimo tvarka:
e jei Sglyga tenkinama, atlickamas Pirmas Sakinys,
e jei ne — po else esantis Antras Sakinys.

Jeigu reikia atlikti kelis sakinius, kai Salyga tenkinama arba netenkinama, tai jie raSomi tarp { ir }.

PavyzdZiai Salyga Ekrane matysite
®x = 4; 7
if (x € 9) v = x + 3; 4<9 true
else y = x + 5;
cout << y;
x = 14; 19
if (x < 9) y = x + 3; 14<9 false
else y = x + 5;
cout << y;
x = 4 6 18
if (x < 9) | 4<9 true
X = X + 2;
y o= x * 3
}
else |
¥ = x = 5;
y = x * 5;
}
cout <££ x << <<y

Galima raSyti sutrumpintg salyginj sakinj, kuriame yra tik Pirmas Sakinys ir veiksmai atliekami tik tuomet, kai
Salyga tenkinama.

if (Sglyga) PirmasSakinys; if (Sglyga) {
Sakiniai, kurie atlickami, kai Sglyga tenkinama ;

}

Salyginio sakinio Sakose galima uzrasyti bet kokius sakinius.
Bet kurioje salyginio sakinio Sakoje galima uZraSyti dar vieng salyginj sakinj, pastarojo Sakose — dar po vieng ir
t. t. Toks sakinys vadinamas sudétingu salyginiu sakiniu.

if (Sglygal) if (Sglygal)
if (Sglygal) if (Sglyga2)
PirmasSakinys; if (Sglyga3)
else AntrasSakinys; PirmasSakinys;
else TrediasSakinys; else if (Sglygad) AntrasSakinys;




CIKLO SAKINYS WHILE

Ciklas yra naudojamas pasikartojantiems veiksmams atlikti. Labai daznai veiksmai kartojami tol, kol tenkinama
nurodyta saglyga. Tokiais atvejais naudojamas ciklo sakinys while.

while (Salyga) while (Salyga) {
KartojamasSakinys; KartojamiSakiniai ;

}:

Vykdant sakinj while pirmiausia patikrinama Salyga:
e jeijos reikSmé yra true (tiesa), tuomet atliekamas KartojamasSakinys,
e prieSingu atveju jis praleidziamas ir atlieckami toliau uz ciklo esantys sakiniai.
e Jei kartoti reikia ne vieng sakinj, raSomas sudétinis sakinys { }.

Naudojant nezinomo kartojimy skaiciaus cikla while, reikia atkreipti démesij j Sivos dalykus:
e jeigu ciklo viduje reikia jvykdyti kelis sakinius, tai jie turi biiti raSomi tarp { ir };

e jei pries pradedant ciklg Salyga yra netenkinama (false), KartojamasSakinys (ar sakiniy grupé)
nevykdomas né karto;

kintamiesiems, kurie yra salygos reiskinyje, pries sakinj while esancioje programos dalyje turi biuti
suteiktos pradinés reikSmeés.

e Ciklo viduje $iy kintamyjy reik§més turi bati kei¢iamos taip, kad kada nors Salyga tapty false.

e Kitu atveju ciklas bus vykdomas be galo daug karty. (Tai amzinasis ciklas.)

CIKLO SAKINYS FOR

Kai i$ anksto Zinoma, kiek karty reikia kartoti veiksmus, naudojamas Zinomo kartojimy skaiciaus ciklas for.
Ciklo for antrasté valdo tik vieno sakinio kartojimg. Jeigu reikia kartoti kelis sakinius, tai jie raSomi tarp { ir }.

for (RI; Sglyga; R2) for (RI; Sglyga; R2)
KartojamasSakinys ; KartojamiSakiniai ;
b
m= 10; n = 12; —I

for (i =m; i <=n; i =1i + 1)
cout << i << endl;

Ciklo Zingsniai Kintamojo i reikimé Salyga: i <= 12 Ekrane matysite
1 10 10 <= 12 true 10
2 11 11 <= 12 true 11
3 12 12 <= 12 true 12
1 13 13 <= 12 false

Ciklas atlieckamas 3 kartus.

Formaliai ciklo for veiksmus galima apraSyti taip:
1. Vykdomas sakinys R1. Paprastai jis naudojamas ciklo kintamojo (kintamasis, kuris vartojamas ciklo
pabaigai apibréZti) pradinei reikSmei priskirti. Sakinys R1 jvykdomas tik pirmg karta.
2. Patikrinama Salyga. Jei jos reik§mé yra true, tuomet atlickamas KartojamasSakinys (arba
KartojamiSakiniai). PrieSingu atveju ciklas nutraukiamas.

3. Vykdomas sakinys R2. Jis nurodo, kaip turi biiti apskai¢iuojama ciklo kintamojo reikSme. Veiksmai
kartojami nuo 2 Zingsnio.

Naudojant zinomo kartojimy skaiciaus cikla, reikia atkreipti démesj j Siuos dalykus:
e jeigu ciklo viduje reikia jvykdyti kelis sakinius, tai jie turi biiti raSomi tarp { ir };

e jei prie§ pradedant ciklg Salyga yra netenkinama (false), KartojamasSakinys (ar sakiniy grup¢)
nevykdomas n¢ karto;




kintamiesiems, kurie yra salygos reiskinyje, pries patikrinant Salyga pirma kartg turi biiti suteiktos
pradinés reikSmés. Jos gali biiti nurodomos pries ciklg arba sakinyje R1 priskyrimo sakiniu, kurie
atskiriami kableliu.

Ciklo viduje kintamyjy, kurie yra salygos reiskinyje, reikSmés turi biti kei¢iamos taip, kad kada nors
Salyga tapty false. Kitu atveju ciklas bus vykdomas be galo daug karty. Toks ciklas vadinamas
amzinuoju ciklu.

NAUDOJAMU IR / AR REKOMENDUOJAMU MATEMATINIU FUNKCIJU SARASAS

Funkcija Paskirtis
int abs(int x); Grazina sveikojo skaiiaus x absoliutyjj diduma. Esant teigiamam ar
neigiamam funkcijos parametrui, rezultatas yra teigiamas.
Pavyzdys:
int x = -10;

cout << "Sveikojo skaifiaus " << x
<< " modulis yra " << abs(x) << endl;

Ekrane matysite:

Sveikojo skai¢iaus -10 modulis yra 10
double fabs (double x); Grazina realiojo skaiciaus x absoliutyjj diduma.

Pavyzdys:

double x = -15.5;
cout << "Realiojo skaidiaus " << x

<< " modulis yra " << fabs(x) << endl;
Ekrane matysite:

Realiojo skaic¢iaus -15.5 modulis yra 15.5

double pow(double x, double y); | Skaifiy x kelia laipsniu y. (Jei y yra 0.5, tai funkcija skai¢iuoja
neneigiamo argumento x kvadrating Saknj.)
Pavyzdys:
int x = 15, y = 3;
cout << "SkaiCius " << x
<< " pakeltas laipsniu " << y
<< ": " << pow(x, y) << endl;
Ekrane matysite:
Skai¢ius 15 pakeltas laipsniu 3: 3325

double sgrt(double x); Skai¢iuoja neneigiamo argumento x kvadrating Saknj.

Pavyzdys:

double x = 15.5;

cout << "Kvadratiné Saknis iS5 realiojo skaiciaus "
<< x << " yra "
<< sgrt(x) << endl;

Ekrane matysite:
Kvadratiné Saknis 18 realiojo skaiciaus 15.5 yra
3.937
int random(int Riba); Grazina atsitiktinj sveikgjj skaiciy is intervalo (0; Riba).
Pavyzdys:

cout << "Atsitiktinis skaidius intervale 0-99: *
<< random({100) << endl;
Ekrane matysite:

Atsitiktinis skaidius intervale 0-99: B84

int rand(void); Grazina atsitiktinj sveikajj skai¢iy i§ intervalo [0; RAND_MAX).
Konstanta RAND_MAX daZniausiai lygi 32767. Norint pasinaudoti kon-
stanta RAND_MAX, reikia prie programos prijungti faily stdlib.h
sakiniu #include <stdlib.h>
Pavyzdys:
cout << "Atsitiktinis skaifius: " <<

<< rand() << endl;
Ekrane matysite:
Atsitiktinis skaicius: 130




